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2 Ruskin

Ruskin is the RBR software that manages your RBR loggers to provide all the data necessary to do your work. Ruskin 
provides a graphical user interface that makes using the loggers easy. You can use Ruskin to do the following:

Configure, schedule, and enable multiple loggers.
Download data after logging.
View data sets graphically.
Export data in various formats.
Change the calibration coefficients for your logger.

Ruskin can be used on PC and Mac.
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3 Revision history

Revision 
No.

Release Date Notes

1.0 7-Oct-2011 Original

2.0 15-Oct-2012 Adding RBRvirtuoso and RBRconcerto, and new 
features

2.1 28-Jan-2013 Adding thresholding and AMT pH calibration, 
editing autoranging, thumbnail view, parameters 
tab, file export, event button, and calibration

3 26-Jun-2013 Initial controlled release, new part #, no other 
changes

4 22-Jul-2013 Ruskin v1.8.3 additions

5 02-Sep-2014 Migrated to new editing system, updated for 
Ruskin v1.8.20

6 22-Dec-2014 Added auxiliary controls

7 12-Jan-2015 Added bursting controls

B 12-Sept-2017 Final revision for standard loggers

C 02-Feb-2018 Logger 3 features

D 12-Dec-2018 Updated installation details, screenshots, added 
auto-deploy features
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Revision 
No.

Release Date Notes

E 13-Mar-2019 Updated plotting information, firmware 
upgrades, and screenshots

F 06-Jun-2019 Added directional sampling, updated 
introduction, updated images

G 04-May-2020 RBRquartz3 BPR|zero features, RBRcoda T.ODO 
customer calibration, updated images, and 
removal of Logger hardware

H 18-Aug-2020 Updated firmware upgrade procedure, added 
annotation collapsing/expanding, and GPS 
plotting
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4 Warranty statement
All data loggers manufactured by RBR are warranted against defects in workmanship or original parts and 
materials for one year. Third party sensors (not manufactured by RBR) are limited to the warranty provided by the 
original manufacturer.

Units suffering from such defects will be repaired or replaced at the discretion of RBR, provided that the problem has 
appeared during normal use of the instrument for the purpose intended by us. The liability of extends only to the 
replacement cost of the instrument. The customer will bear all costs of shipment to us for repair; all other costs, 
including return shipment, will be borne by RBR.

This warranty does not cover consumables or normal wear and tear, nor does it cover damage caused by negligent use 
or mishandling. Attempted modification or repair of any unit without the prior consent of RBR will immediately void any 
warranty in force.

Users are expected to maintain a regular program of calibration.

We reserve the right to grant or refuse warranty repairs at our discretion if we consider that there are reasonable 
grounds for doing so.
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5 Introduction
This document introduces you to Ruskin and helps you to use it effectively from the start. It is written specifically for the 
RBRvirtuoso3, RBRduo3, RBRconcerto3, RBRquartz3, and RBRmaestro3 loggers.

You can access the Ruskin User Guide on the USB data stick provided when you purchase a logger, from the Help menu 
in Ruskin, and on the RBR web site, at www.rbr-global.com.

Release notes are automatically displayed each time you install an updated version of Ruskin. The most recent release 
notes are also available from the Help menu in Ruskin. For information about operating and maintaining your data 
logger, see the Logger Hardware section. It helps explain how to change the battery and change desiccant, including 
other useful information, such as inspecting and replacing O-rings.
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6 Installation

6.1 Install Ruskin on a PC
You can install Ruskin on a PC that runs the Windows 7, 8, 8.1, or 10 operating system.

The minimum requirements for Ruskin are:

OS = Windows 7
Processor speed = 1.4GHz 
RAM required = 2GB 
Display resolution = 1024x768 recommended 
HDD space for installation = 500MB

Steps

Connect the data stick included with your instrument to a USB port.
Navigate to the folder Ruskin Installation and double click on the file RuskinSetup.exe.
Follow the installation wizard. By default, Ruskin will be installed to C:\RBR.
The logger uses a USB interface to communicate with Ruskin.
At the end of the installation, a prompt will appear asking, "Would you like to install the logger driver 
at this time?"
Click Yes to install the drivers.

A shortcut to Ruskin appears on the desktop and in a Start menu folder called Ruskin.

6.2 Install Ruskin on a Mac
You can install Ruskin on a Mac running OS X 10.12 (Sierra) or later.

Steps

Connect the data stick included with your instrument to a USB port.
Navigate to the folder OSX and double click on the file Ruskin.dmg.
When the disk image window opens, drag the Ruskin icon into the applications directory and wait for 
the copy to complete.
To open Ruskin for the first time navigate to your applications directory, locate Ruskin, right click on 
the icon, and select Open.

You may need to run the setup application as an administrator to install the driver correctly.

Please note that the most recent version of Ruskin can be found at https://rbr-global.com/products/software

https://rbr-global.com/products/software
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5. The dialogue box shown below will prompt you to authorize the opening of Ruskin. 

An application named Ruskin appears in the Applications folder.

You may want to drag the Ruskin.app application to the Dock.

6.3 Update Ruskin
To take advantage of new features and bug fixes, ensure that you are using the most recent version of Ruskin.

It is not necessary to uninstall an older version of Ruskin before installing a newer version. The installation program 
deletes the older files before installing the newer ones. It does not delete any Ruskin data files or log files.

The most recent version of Ruskin is always available on the RBR website (www.rbr-global.com). However, if you 
already have an older version of Ruskin installed, Ruskin automatically notifies you that a newer version is available 
when you start Ruskin. You can check to see if a new version is available from within Ruskin navigating to the menu Hel
p > Check for updates. If you have a broadband connection, we recommend that you follow the installation 
instructions that appear on your computer. Otherwise, request a USB stick from RBR.  

It may be required that you navigate to System Preferences > Security & privacy to allow apps downloaded 
from “Anywhere” to complete the installation.



Although you can specify a different folder for the working directory for the software, we recommend that you 
use the default Applications folder.



If you do not have a broadband connection and/or are unable to install the Ruskin updates, update 
notifications are available via email. To receive these notifications, send an email to: support@rbr-global.com
subject: "Ruskin update request".



http://rbr-global.com/support/software
mailto:support@rbr-global.com?subject=Ruskin%20update%20request
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6.4 Uninstall Ruskin
If you no longer need to manage RBR instruments from your computer, you can uninstall Ruskin.

It is not necessary to uninstall an older version of Ruskin before installing a newer version. The installation program 
deletes the older files before installing the newer ones. For more information, see Update Ruskin.

Windows 7, 8, 8.1, or 10

Go to Start > Control Panel > Programs, and under Programs and Features, click Uninstall a program. In the list, 
locate Ruskin – click Ruskin to highlight it, and then click Uninstall.

OS X 10.5 or later

Move the Ruskin application from Applications to the Trash.

Removing Ruskin will not delete your data files or your diagnostic logs.



RBR#0006105revH  –  14

•

•

1.

2.

3.
4.

7 Provide your feedback
You can get in touch with RBR in several different ways:

Send us an email.  For a technical question, write to support@rbr-global.com. For general inquiries, 
use info@rbr-global.com.
Send us a bug report from within Ruskin itself.  Use the Help menu > Comment on Ruskin.  
This allows you to include the diagnostic logs, and any other files (RSK datasets, screenshots) that will 
help us reproduce the problem and help you as quickly as possible.

Steps

From the Help menu, click Comment on Ruskin.
The Feedback to RBR dialog box appears.
Enter your identification information, for example, email address and name, and then summarize your 
comments. 
Provide a detailed description and add any attachments, if required. 
Click Submit to submit the report. 

mailto:support@rbr-global.com
mailto:info@rbr-global.com
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8 Quick start

8.1 Deploy an instrument
Before you begin using your RBR loggers, you may want to experiment with the simulated loggers that are included in 
Ruskin. For instructions on simulating a logger, see Using a simulated logger.

When you are ready to use your own RBR loggers, we recommend that you follow the following steps to ensure that you 
measure exactly what you want on the first attempt. 

Steps

To establish communication between the logger and a computer, remove the battery end cap and 
locate the USB-C connector, just below the battery cover, or on the underside of the battery end cap 
for the RBRquartz3 BPR|zero. The supplied interface cable is plugged into this connector. The USB-C 
connector can be inserted with either side facing up.
The logger should appear in the Navigator view after a few seconds.
If you are using the logger for the first time, you can use either the default preferences or specify your 
preferences to apply to all your loggers. For more information, see Preferences. You can change these 
preferences at any time.
Click the logger that you want to use. Ensure that it contains the sensors you expect to find on the 
logger by viewing the Information tab in the Properties view on the right side of the Ruskin window. 
For more information, see View information about a logger.

If you want to see live data sampled every few seconds but not saved, select the fetching ( ) button in the toolbar 
located above the Plot view. The Plot view is located at the bottom of the Ruskin window.

Click the Configuration tab to specify streaming.

If you want to view or modify calibration coefficients, click the Calibration tab. For more information, 
see Calibration tab.
Click the Configuration tab > Sampling section to schedule the logger to take samples when and as 
often as you want within the limits of your logger.
 For more information, see Schedule a logger.

Ruskin prevents you from enabling a schedule that exceeds the memory capacity of the logger. Ruskin also shows the 
estimated battery usage required to use your logger as scheduled. You should seriously consider this information 
before you enable the schedule.

On the Configuration tab, click Enable to take samples according to the schedule that you specified. 
If you enabled streaming data, you will see the data appear immediately once the logger is enabled in 
the Plot view toolbar.

You must specify your preferences regarding these features before you enable the schedule. For more 
information, see Configure a logger.


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• If you want to download data, click the Download button from the Configuration tab to download all 
the data saved since your schedule was enabled. For more information, see Download. The focus 
changes to the new dataset in the Navigator view, and the static data appears in the Plot view. You 
can now export the downloaded data to a file in Excel or text. You can also save the image as a PDF or 
PNG file for viewing outside Ruskin.

 

8.2 Batteries
RBR dataloggers can use most chemistries of AA battery. 

We estimate the deployment time based on a capacity calculated from the nominal voltage and miliamp hours (mAh)

Name Chemistry Model Voltage (V) mAh

Lithium thionyl 
chloride

LiSOCL2 Tadiran TL-4903S 3.7 2400

Lithium Li-FeS2 Energizer L91AA 1.5 3500

Alkaline Zn-MnO2 Rayovac AL-AA 1.5 2500

Li-ion LiNiMnCo BatterySpace 
LC14500

3.6 750

NiMH NiMH Duracell 
DX1500B4N

1.2 2400

Lithium thionyl chloride batteries are only recommended for T, D, T.D, and C.T.D instruments. Sensors with 
high in rush current will not work correctly on this type of battery.



The different chemistries affect the deployment time, so ensure you have selected the appropriate battery 
chemistry in the power section of the configuration tab when using the autonomy engine to get the most 
accurate deployment estimate.



Mixing batteries of different chemistries, brands, and age will reduce performance and potentially damage the 
instrument. Batteries that are not matched properly can become overheated, causing them to leak and 
potentially explode.


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8.3 Using a simulated logger
Ruskin can simulate most logger types that RBR produces. We recommend that you experiment with your type of 
simulated logger before enabling a schedule for your actual RBR logger. This practice helps you become more familiar 
with how an RBR data logger interacts with Ruskin and how to configure the settings and features within Ruskin. 

Configuring a simulated logger

From the Instruments menu, click Simulate instrument. 
The Configure Simulated Instrument dialog box appears.
Click on the tab that correlates to your logger's family type. 
For example, if simulating an RBRvirtuoso3, you would select the Standard Instruments tab.
Select from the information provided within the logger's tab.  
Click OK. 
The simulated logger appears under Instruments in the Navigator view.
Go to the Navigator view and click the new simulated logger to see the general information and 
configuration settings in the Properties window. 

You can now work with this logger the same way as you work with a real RBR logger, including: configuring, calibrating, 
and fetching data. Currently simulated instruments cannot be enabled or downloaded. For more information, see Deplo
y an instrument.

Multiple loggers, both real and simulated, can be listed in your Navigator window.

8.4 View information about a logger
You can view static information about a logger at any time as follows:

In the Navigator view, click the appropriate logger.

 The Information tab in the Properties window on the right side of Ruskin identifies the logger. Its general information 
such as model, serial number, generation, firmware version, battery status, and the channels.

If you want to remove a simulated logger, in the Navigator window, right-click the logger and click Disconnect 
from instrument. You can also use the Instruments menu.


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8.5 Recover an instrument and download data
When the deployment is complete recover your instrument and follow these steps to download your data.

Steps

Start Ruskin.
Carefully open the battery end cap of the logger.
Insert the USB-C connector into the logger and connect the cable to your computer.
The logger appears in the navigator window and then navigate to the Configuration tab and select 
Download... (see Download).
Save the file to a preferred location.
Evaluate your data (see Analysis).

8.6 Data format
Data can either be streamed from an instrument (requires a deployment to be enabled) or it can be fetched from the 
instrument.

Realtime data can be formatted in a limited number of formats as described below. Each format is listed alongside and 
an example output for an RBRconcerto3 C.T.D: 

Output format 
option

Instrument 
setting

Example data

Standard 
resolution

caltext01 2018-12-10 13:06:38.000, 0.0005, 
22.9536, 10.1149

Flooded loggers may be under pressure and opening a logger may be dangerous - take precautions when 
opening a logger


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Output format 
option

Instrument 
setting

Example data

Standard 
resolution (units)

caltext02 2018-12-10 13:06:38.000, 0.0005 mS/cm, 
22.9536C, 10.1149 dbar

Highest resolution 
(RBRquartz)

caltext03 2018-12-10 13:06:38.000, 
0.000525642944, 22.939636, 10.1149120

Engineering caltext04 2018-12-10 13:06:38.000, 
525.642944e-006, 22.9396360e+000, 
10.1149120e+000

The output format can be changed in Ruskin from the instrument's Configuration tab. There is a drop down menu item 
called format in the Options section.

Standard resolution
All data values are shown to 4 decimal places

Standard resolution (units)
All data values are shown to 4 decimal places
Following the value, and separated from it by a space, is a short string representing the units of 
measurement.

Highest resolution (RBRquartz)
All values are shown with enough significant digits ensuring no loss of resolution.

Engineering
All values are shown in 'engineering-notation' floating point (same as scientific notation except 
that the exponents are constrained to be multiples of three) with enough significant digits 
ensuring no loss of resolution.

The values following the timestamp are all the enabled channels. To identify which channels are enabled and their 
order in the string you can use the command outputformat channellist.

Example:

>> outputformat channelslist

<< outputformat channelslist = conductivity(mS/cm)|temperature(C)|pressure(dbar)
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8.7 Ruskin Mobile

8.7.1 Connecting over Wi-Fi to a mobile device
Install the Ruskin App on your mobile device by going to the Apple App store or Google Play.

Steps

Twist ON/Off on the logger end cap to activate the Wi-Fi. 
You may need to Twist the logger either to the ON position or OFF position to activate the Wi-Fi, but 
remember to twist to the OFF position to pause the logger.

The Android app will automatically scan Wi-Fi networks for any instruments. On iOS you must connect 
to the instrument in your Wi-Fi settings. There is a convenience button on the landing page as shown 
below. The logger should appear automatically under "Choose a network..." The name appears as the 
RBR serial number of the logger. Tap it to connect to the instrument. Please allow your iPhone to 
connect before you exit the Settings screen, i.e. that a blue check mark appears to the left of the Wi-Fi 
network.

The twist activation is intended to start sampling or pause sampling, however twisting ON or OFF also 
enables the Wi-Fi module to transmit. This is the method to activate the Wi-Fi if it is not active.


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Exit Settings to return to the Home screen. 
From the Home screen, tap the Ruskin App (the App will automatically search for the logger and 
connect to it).

The Wi-Fi is disabled after 60 seconds of inactivity. Twist the logger ON or OFF to activate the Wi-Fi.
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After connecting to the logger, you are automatically in the Instrument view of the app. The different views you can go 
to are Instrument, Datasets and Settings, located at the bottom of the screen. Tap Datasets to view a list of local 
datasets, and (optionally) remote datasets you have stored in your Dropbox account. This is also how you can share/
upload and view your data, described in more detail later.

8.7.2 Instrument Tab
When connected to an instrument, the top of the Instrument tab shows the status of the logger indicating whether it is 
currently logging samples, how many samples the instrument has taken, and what the sampling rate is set to. The 
sampling rate can only be changed when the deployment has been stopped as shown below - note that the rightmost 
frequency indicator has become a picker.

The logging state (ON/OFF) in the example below, controlled by twisting the instrument end cap to an ON or OFF 
position, should not be confused with starting/stopping a deployment, controlled using the red START / STOP button in 
the lower right corner of the Instrument tab. This is described in more detail later.
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Real-time Data
A sparkline chart shows the last 50 readings for each of the measured channels (or the last 150 readings when using a 
tablet). These are typically out-of-water samples and serve to provide real-time feedback from the instrument. To view 
charts of the full deployment, tap the light blue "VIEW" button beneath the sparkline.

Geotagging
Your logger does not have a GPS - location information for the logger is gathered using your phone/tablet's location 
capabilities.

The "LAST TAGGED LOCATION" in the center of the Instrument tab, indicates when the last GPS coordinates were added 
to the dataset. Whenever the mobile app connects to an instrument, it automatically logs the location in the dataset. 
The location is taken at the time of connection, so should a download take several minutes and the boat be moving, the 
initial location is captured. Should a more accurate location fix be attained within the first minute after connection, 
those coordinates are used instead.
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As the app uses GPS, a clear view of the sky will allow a more accurate waypoint, rather than downloading inside a ship 
cabin for example. To conserve the battery life of your phone, GPS tracking only occurs when the Ruskin app is open or 
when you are recording a track of your location (described in more detail later). It can take a few moments after 
opening the app to get an accurate location fix - when GPS is working well, an accuracy of around 5 metres can be 
expected.

A GPS waypoint fix can also be manually added at any time by tapping on the purple "TAG" button. The last tagged 
location will be updated to indicate the coordinates and accuracy of the manual waypoint. Both types of waypoints 
described (manual tags and those taken automatically on download) can be seen plotted on a map in the Locations tab.

Channels

Scrolling to the bottom of the Instrument tab reveals the instrument's Measured and Derived Channel lists along with 
their units of measurement. The colored circle to the left of each channel indicates the sparkline color used to represent 
the latest readings from that channel.

8.7.3 Starting or Stopping a Deployment
The red button in the bottom right corner reads either START or STOP. If a deployment has been started the STOP 
button ends that deployment, and likewise, if a deployment has been stopped, the button reads START to begin a new 
deployment.

When a new deployment is started, the data on the instrument will be erased. Also, once a deployment has been 
stopped, it can not be resumed - a new deployment must be started, wiping the data on the instrument.
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One dataset is created for each deployment. Deployments are typically long running, consisting of many sampling 
periods (by twisting the end cap to ON) and paused periods (by twisting the end cap to OFF). 

While a deployment is stopped, the sampling rate can be adjusted as described earlier. A deployment can only have one 
sampling period, thus, once the deployment begins, the sampling rate picker in the top right corner of the Instrument 
tab can no longer be changed.

Whilst the deployment is stopped, twisting the instrument to either ON or OFF will activate the Wi-Fi, but the instrument 
will not buzz as the instrument is not sampling.

From Ruskin Desktop, when you start a deployment, you are given the option to do so in an "EasyParse (mobile) 
compatible" mode, or in a more complex mode where calibration data is segregated. If the existing deployment is not in 
the EasyParse (mobile) mode, the mobile app can still download the data, but the app will not display a sparkline, nor 
will users be able to view charts.

When starting a new deployment from the mobile app, the new deployment is always set to the EasyParse (mobile) 
mode, regardless of the previous deployment's mode.

Clock Sync
When you start a deployment, you can automatically set the instrument's time. The time is taken from your phone/
tablet. As the instrument has a clock but no concept of time zones, you may choose to use UTC or local time, or you 
may choose to set no time at all. Note that should you leave the logger without batteries for more than a few seconds, 
the clock will reset (back to the epoch). Starting a new deployment with this setting enabled provides a convenient way 
to correct the clock.
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8.7.4 Accessing Datasets

Datasets are separated into 2 lists - datasets that are locally stored on your device (from instrument downloads 
performed on this phone/tablet), and "Archived Datasets" that are stored on Dropbox. If you have not set-up Dropbox, 
the second list will not appear. Note that there are a number of ways datasets can be uploaded from your device - you 
do not necessarily need to use Dropbox. Setting-up Dropbox and using other means of sharing datasets are explained 
later.

A sample dataset, captured from a real deployment, is also available to demonstrate features of the app.

If an instrument deployment was started from Ruskin Desktop, and the user opted not to use the EasyParse (mobile) 
mode, the dataset icon will include an exclamation mark.
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You can view charts for datasets stored locally on your device. You can NOT view charts for datasets that have been 
archived to Dropbox and removed from your device. For this reason, you may or may not choose to automatically 
remove local datasets once you have uploaded them (explained in the Dropbox section).

Uploading and Sharing Datasets
On iOS, swiping to the left on an item in the Datasets list will reveal some operations that can be performed on that 
dataset. On Android, long-pressing the item reveals the equivalent context menu.

The "Share" option shows a context menu of the available share options for that dataset. These are only available for 
local datasets. What these are, depends on the apps you have installed on your phone, but a number of options come 
without additional apps. On iOS these include sharing by email, AirDrop, and save to Files (as of iOS 11). If you would 
like to see your cloud drive (Google Drive, Baidu, Box, Microsoft OneDrive, iCloud, Dropbox etc.), you need to install that 
app, after which it should be available as a share destination.

Dropbox
There are additional features available for Dropbox sharing, that incidentally don't require the Dropbox app to be 
installed. You can bulk upload your Datasets to Dropbox. To enable Dropbox integration, you must sign in to Dropbox. 
The option for this is at the top of the Settings tab.

Once signed in to Dropbox you can press the cloud button in the top right corner of the Datasets tab to bulk upload all 
your local datasets. As the datasets upload, the icon will transition from an upwards arrow to a check-mark.
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You can choose to automatically delete the datasets from your device once they have been uploaded. The preference 
for this, which by default is set to delete the local copy, can be found in the Settings tab.

8.7.5 Charting
Selecting the blue "VIEW" button under the Sparkline will show charts for the connected instrument's existing 
deployment. Charts for any local datasets can also be viewed by tapping on that dataset in the Datasets list. The charts 
are separated into casts, that is, each time the instrument descends and ascends again is considered to be a cast, and 
one chart is created for each cast.

In the example below, there are 29 casts (pages). Swipe left and right to view the chart for each cast. Note that when 
testing the out-of-water samples, there will only be one chart as the instrument determines the start and end of casts by 
depth (pressure) readings.  
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In portrait orientation, channel data is plotted by depth. Only downcast data is plotted - the upcast data is omitted. As 
the instrument sensors face downwards, the downcast provides the most accurate data - upcast data can be subtly 
impacted by the turbulence from the leading instrument housing on the ascent.

When viewing out of water samples, the downcast chart will appear like a random plot. Only once used in a real cast will 
the true usefulness of this plot become apparent, as illustrated above.

In landscape orientation, the channel data is plotted by time. Depth is inverted so the bottom reading on the chart 
intuitively represents the bottom of the cast.

Pinch-to-zoom in on data. The chart axes adjust relative to each other on zooming and panning around the chart so that 
all chart series occupy the full height or width of the chart and can be easily compared side-by-side.

The Details drawer, shown by tapping the top-right corner, reveals data about the displayed cast and the deployment. 
The deployment data is also available in the "Info" context menu of the Datasets list.
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You can also tap on the legend at the bottom of the charts to plot or hide channels. In the Settings tab you can opt to 
have your charts plot temperature by Celsius (default) or Fahrenheit, and whether depth is plotted as metres (default), 
feet or fathoms. This is purely a viewing preference for your phone/tablet and in no way changes the units in which the 
data is captured in the dataset.
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8.7.6 Location & Tracking
As mentioned earlier, your logger does not have a GPS - location information for the logger is gathered using your 
phone/tablet's location capabilities. A waypoint is automatically added to the RSK's geodata table whenever the 
instrument connects and also whenever the user taps the TAG button in the Instrument tab.

New to iOS version 2.3, and coming soon to Android, is a Location tab that allows users to view Datasets on a map. 

The above sample screens shows the path that the boat took and the locations of the profiles.

There are 3 types of pins...

Profiles are shown as numbered red pins.
Manual Tags are shown as purple pins with the letter "T".
Download tags (automatically added whenever the instrument downloads to your phone) are shown 
as blue pins with the letter "D". Note that these are hidden by default - to display the download pins, 
use the switch in the info drawer.

There are 3 colors used to draw the track...

The downcast segments of the track are drawn as a red line.
The upcast segments of the track are drawn as a green line.
The segments of the track that are not associated with a profile (e.g. the instrument was out of the 
water) are drawn with a light gray line.
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Tapping on a map pin invokes an info window. In the case of Profile pins, this includes a link to view the chart for that 
profile.

8.7.7 Using the Tracking Feature
As Ruskin's tracking feature uses the location capabilities of your phone, your phone should be sufficiently close to your 
instrument during the deployment.

When you download your instrument to your phone, Ruskin Mobile will calculate the locations of profiles using the 
timestamps logged against the instrument samples and events.

The clocks on the instrument and your phone do NOT need to be synchronized as Ruskin Mobile will 
factor in any clock offset into the calculations.
Also, note that you can stop and start tracks during a deployment - Ruskin Mobile can stitch together 
data from multiple tracks into one RSK.

To start tracking your location...

Select the Locations tab.
Ensure "My Location (Not Tracking)" is selected in the drop-down.
Tap on the "START" button in the bottom right corner. The first time you use this feature on iOS, you 
will be prompted to "Allow Ruskin to also access your location even when you are not using the app". 
Please select "Always Allow" otherwise when you leave the app, tracking will cease. 

Tracking will continue for up to 24 hours, even with the app in the background, unless you come back to Ruskin and 
select "Stop Tracking". Force closing the app (double-tapping the home button and swiping upwards) will also interrupt 
GPS tracking. GPS tracking does increase battery drain, so you'll likely only want to use this feature during the 
deployment.

Track files can be seen in the drop-down at the top of the Locations tab, displayed next to a purple ship icon and also in 
the Datasets tab where they can be uploaded/shared/deleted etc. To view a previous track in the Locations tab, select it 
from the drop-down at which point you will notice the current location details disappear from the header along with 
the start/stop and recenter buttons. Viewing other tracks does NOT affect the recording of the current track but you will 
need to select the "Current Track" from the drop-down to stop/start tracking or to view current location stats.

You may wonder why viewing a track is NOT showing any profile, tag or download pins... when you have a track 
selected you are viewing just that track, independently of any instrument data. Selecting an RSK listed in the Locations 
drop-down will display all track and location data captured during that deployment along with the profile, download 
and tag pins.

If no tracks coincide with the deployment, only download (and possibly tag) pins will be displayed. 
(Remember that download pins are hidden by default, so the map may appear empty.) Note however 
that in the absence of track data, Ruskin Mobile searches for any automatic waypoints (from 
instrument downloads) and will sometimes be able to position some profiles from these and thus 
display some profile pins.
If track data is not available for the full deployment, some profile pins may be missing from the map. 
You can see how many profile locations could be determined from the info drawer.

8.7.8 GPX Files
One track creates one tracking file. Track files use the GPX format, augmented with a couple of minor extensions. A 
track file is independent of any RSK, but tracks are used to inject location data into the RSK whenever the RSK is 
downloaded. The RSK's geodata table will contain one row for every GPS entry captured during the deployment. In 
most cases, users don't need to be concerned with the GPX file as all the needed data will be contained within the RSK.

https://en.wikipedia.org/wiki/GPS_Exchange_Format
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Note that the GPX/track files can also be uploaded from the app independently of RSKs. You may wish to use a track to 
illustrate your course on a map using various online tools, or you may wish to convert it to other formats such as 
GeoJSON or KML.

https://geojson.org/
https://en.wikipedia.org/wiki/Keyhole_Markup_Language
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9 Configure a logger
Before you enable a logger schedule, you can configure the logger to suit your requirements.

The instructions to configure a tide or wave logger are different than the standard loggers and can be found in Tides 
and waves.

If your logger schedule is already enabled when you decide to change the configuration you must stop running the 
schedule, make your changes, and enable the schedule again. However, any data stored so far on the logger will be lost.

Within the Configuration tab the Enable, Revert settings, and Use last setup buttons are found. When you 
click Enable, the logger setup parameters are stored to the logger and the schedule is enabled. When you click Revert 
settings, you set the logger configuration back to previous settings. 

Use last setup is intended for configuring multiple loggers using the same schedule. For example, to set up three |tide 
loggers with exactly the same parameters, set one logger up and enable it; connect the second and third logger and 
when you click Use last setup button, these two loggers will be set up with the same parameters as the first logger. This 
includes the logger clock time, start and end logging times, sampling period (or rate), gating condition, and tide or wave 
sampling parameters for |tide or |wave loggers.

Overview of the Configuration tab

Group Field Explanation

Schedule You can configure multiple settings that include when the 
logger starts and stops logging, what type of sampling 
regime takes place, and the type of measurements speed.

For more information about scheduling a logger, see 
Schedule a logger.

Status Indicates the loggers current state (Not enabled, Logging in 
progress, Paused).

Clock Displays the current logger time in the set locale.

This time can only be changed by syncing the time with the 
host computer clock. This can be done either in UTC or in 
the local timezone.

You can preserve the data by downloading it to a file before you enable the schedule again.
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Group Field Explanation

Power Internal Specifies the type of batteries installed in the logger. This 
parameter is used by the autonomy engine to estimate 
deployment life.

The 'Fresh' option is used to indicate that fresh batteries will 
be installed in the logger for the next deployment. This 
parameter is used by the autonomy engine to reset usage 
statistics when estimating deployment life.

External Specifies the type of external power supply powering the 
logger for the deployment for use in the autonomy engine 
calculations.

The 'Fresh' option is used to indicate that an unused 
external supply will be used for the next deployment. This 
parameter is used by the autonomy engine to reset usage 
statistics when estimating deployment life.

Extended 
battery 
endcap

Specifies the inclusion of a powered endcap which will be 
accounted for in the autonomy engine.

If a powered endcap was not purchased do not select this 
option as it will skew deployment life.

Sampling Mode Specifies the sampling regime to be used on the next 
deployment.

Each sampling regime requires a specific set of controls. For 
more information on the controls refer to their control pages

Sampling modes: Averaging,  Bursting, Directional, Tide, and 
Wave.
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Group Field Explanation

Gate Specifies the condition which must be fulfilled before 
regular sampling will occur. There are three (3) options:

None: Disables the feature so that the scheduled start and 
end time gate sampling

Twist activation: Starts the logging schedule when the end 
cap is twisted in the 'on' position. For information about 
enabling twist action, see Twist activation.

Marine wet switch: Starts the logging schedule when the 
logger detects it has entered the water. 

Options Realtime Specifies the connection to which live data will be streamed. 
There are three (3) options:

None: Data will not be streamed to any external connection

Serial: Data will be streamed over an external serial 
connection (RS-232 or RS-485).

USB: Data will be streamed over an external USB 
connection.

For more information about real time data configuration, 
see Fetching and streaming data.

Format You can configure settings for obtaining real time data from 
your logger (provided it is equipped with an external data 
port). You can select one of the four live data output 
formats.

Serial Specifies the baud rate of the external serial connection. 
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Group Field Explanation

Mode Specifies the external serial connections communication 
protocol.

(RS-232, RS-485 full duplex, UART (OEM))

Storage Specifies the format with which the logger will record data 
internally.

The standard format is Desktop, however, to improve the 
download speed over Wi-Fi-enabled loggers, select Mobile.

Wi-Fi Specifies the use of the Wi-fi module for the deployment. 

Note: This parameter is not a toggle for the powered state of 
the Wi-Fi module, it only specifies if the logger should use 
the Wi-Fi module. The powered state is controlled by the 
logger itself.

Voltage 
sensors

Channel Specifies the index of voltage channel

Latency Specifies the time (ms) required to wait after power up for 
the sensor to settle in order to take a reading

Current Specifies the amount of current (mA) the sensor requires to 
operate

Ranging 
sensors

Sensor Specifies the name of the sensor and its channel index

Range Specified the gain level used on the specified sensor for the 
deployment. This parameter can be set to an auto-ranging 
setting or to a fixed gain setting. The fixed gain setting is 
specified by selecting one of the ranges specified.

Valve control Status The current position of the valve
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Group Field Explanation

Set position Manually toggles the valve between the two possible 
positions

Schedule 
movement

Enables the ability to schedule the movement of the valve to 
the atmospheric position and define:

Interval - the time between movements
Duration - the time spent in the atmospheric position
If the first atmospheric duration should be skipped

9.1 Schedule a logger
You can schedule when your loggers start logging readings and specify the sampling rate. Ruskin indicates any 
unattainable conditions in the defined schedule at the bottom of the Configuration tab, and the Enable button is 
greyed out.

 

Before enabling the logger, verify the available settings found in the groups: Schedule, Sampling, Options, Voltage 
sensors, Ranging sensors, Valve control, and Power.
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Steps

Highlight the instrument in the Navigator window, click the Configuration tab.
Adjust the time on the logger

Click Local to synchronize with the computer in the local time zone.
Click UTC to synchronize with the computer in the UTC time zone. 

Specify the Start date and time you want to start running the schedule or select the Now checkbox to 
start logging when the Enable button is pressed. 

The estimated logging End date display is based on the configuration of the sampling schedule and 
regime. It is calculated by the autonomy engine and provides feedback on which parameter (power or 
memory) will be exhausted first.

Select the required Sampling mode from the available options.

Specify the sampling Speed
To specify a rate (faster than 1s) click the Rate option and then choose the appropriate 
selection from the drop-down menu
To specify a period of 1s or slower ensure the Rate option is not selected and set the time in 
HH:mm:ss format

Specify a sampling Gate condition
None: Use the start and end time to gate sampling.
Twist activation: Starts the logging schedule when the end-cap is twisted in the 'on' 
position. For information about enabling twist-action, see Twist Activation.

The display of the above groups are based on the logger capability. Not all groups are visible.

If you select and then clear the Now checkbox, you can then manually modify the current date and time 
instead of the original values.



The Start date and time is only editable If the gating condition selected is None otherwise, the gating 
condition selection will be what controls the start of logging.



The estimated logging End date display is based on the configuration of the sampling schedule, mode, 
and power selections. It is calculated by the autonomy engine and provides feedback on which 
parameter (power or memory) will be exhausted first.

The parameter in the green bar indicates the limitation of the deployment and as such is what the 
deployment end date is based on.

The parameter in the orange bar indicates how much longer the deployment may last if the preceding 
parameter was not a factor.



Not all sampling regimes are available on all loggers.

See Average, Burst, Directional, Tide, and Wave for information on how to configure these regimes

https://docs.rbr-global.com/display/RSKDOC/.Twist+Activation+vD
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Marine wet switch: Starts the logging schedule when the logger detects it has entered the 
water. For information about wet switch settings, see Marine Wet Switch.

Click Enable to store the configuration into the logger and start the logging process.

9.1.1 Autonomy engine
The estimated battery life for the selected deployment is shown in Ruskin's Autonomy Engine in the Configuration tab:

When to replace the batteries
Compared to the cost of deployment, the cost of a new set of batteries is close to negligible. We highly recommend that 
the batteries be replaced before every deployment unless there is no doubt that they have sufficient capacity.

Battery voltage does not decrease linearly and is therefore not an accurate indicator of battery capacity.

If the End logging date is power dependent and you know that the logger will be operating under very cold 
conditions, you may want to lower the demands on the battery by lengthening your sampling period or opting 
for different battery chemistry.



An error message appears at the bottom of the Configuration tab if the sampling period is too fast for your 
logger. This typically means that one of the sensors has a long latency.



If the Enable button is disabled, an error message appears.

If you enable the logger, and it is not your first schedule, you will see the warning The contents of memory will 
be erased! Before proceeding, you should download the data from the logger (see Download). If you are sure 
that the information is stored, then click Erase and enable logging.



When the Enable button is clicked the logger evaluates the current dataset in memory. If one exists a warning 
appears indicating that the contents of memory will be erased. If you want to save the existing data, you must 
download the data to a file before proceeding. You can do this from Properties view > Configuration tab and 
select Download. For more information about downloading a file, see Download.



When in doubt, replace the batteries.
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Predicting battery life
Battery life prediction is a complicated issue. In RBR loggers, battery life is a strong function of the type of logger, the 
type and number of sensors attached, the sampling scheme (sampling period and the use of: thresholding, real-time 
data collection and averaging), and the temperature of the water during the deployment. Manufacturers' data for the 
batteries do not provide information that can be directly related to way the batteries are used in RBR loggers.

The Ruskin software calculates the expected battery usage (in mA hours - mAh) for the logger during setup . The 
nominal capacity of each type of battery is described in the batteries section and is given in mAh at room temperature. 
The software will warn the user if the expected battery usage for a particular deployment scenario is approaching the 
theoretical potential mAh. The software will not prevent a logger from being started even if a warning is given. In tests 
at RBR Ltd. of multiple examples of various brands of batteries at 6°C, all examples were able to provide the threshold 
capacity defined in our batteries section. The user should view these predictions and further de-rate the batteries if the 
expected deployment is in cold water. 

RBR continues to characterize battery life in its loggers and will continue to improve the battery life calculator in future 
versions of Ruskin.

9.2 Stop logging
Logging stops on its own when one of the following occurs:

The end logging time is reached.
The gating condition is no longer met.
The power is removed or depleted.
The logger memory is filled.

To manually stop the logger, highlight the logger in the navigator, click the Configuration tab and select Stop.

 

9.3 Averaging
Averaging is a sampling mode which collects data at a certain rate then averages those samples to produce a single 
value which is stored in the logger memory.

There are three main parameters required to be configured for averaging mode:

Speed: Specifies the rate at which samples will be collected.
Duration: Specifies the time range over which to average.

The Duration must always be longer than the sampling Speed.
Interval: The repetition period for performing the averaging.

RBRquartz BPR|zero

The RBRquartz3 BPR|zero does not support this sampling mode, the instrument can only operate in 
continuous mode.


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• The Interval must always be longer than the Duration.

This sampling mode can be activated by selecting Average in the Mode drop-down menu in the Sampling section on 
the Configuration tab

There are two versions of the Average Sampling section that can be used, either simple or advanced. This option can 
be set in Preferences.

Simple form:

In the simple form only pre-defined selections can be made. A more complex setup can be set by using the advanced 
version as follows.

Advanced mode:

In the example above, 1 minute of 2 Hz (2 times a second) samples are taken and averaged. This cycle repeats every 5 
minutes.

A single averaged sample is recorded at the Interval rate. All other samples used to perform the average 
operation are discarded.


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9.4 Bursting
Bursting is a sampling mode which collects a specified number of samples at a specified rate and repeats this operation 
at a specified interval.

There are three main parameters required to be configured for averaging mode:

Speed: Specifies the rate at which samples will be collected.
Duration: Specifies the number of samples to record.
Interval: The repetition period for performing the burst.

The Interval must always be longer than the time it takes to obtain the specified number of 
samples.

This sampling mode can be activated by selecting Burst in the Mode drop-down menu in the Sampling section on 
the Configuration tab

There are two versions of the Burst Sampling section that can be used, either simple or advanced. This option can be 
set in Preferences.

Simple form:

In the simple form only predefined selections can be made.

In the example above, 512 samples will be recorded at a rate of 2Hz which will take 4 hours 16 minutes to complete. 
This cycle will be repeated every 5 minutes.

A more complex setup can be set by using the advanced version as follows.

Advanced mode:

Only loggers with the |fast sampling feature (|fast8, |fast16, or |fast32) support the ability to sample in a burst 
mode.



RBRquartz BPR|zero

The RBRquartz3 BPR|zero does not support this sampling mode, the instrument can only operate in 
continuous mode.



http://docs.rbr-global.com/display/RSKDOC/.Preferences+v5
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In the example above, 2 samples will be recorded every 1 second.

9.5 Directional
Directional dependent sampling is a sampling mode which collects samples at specified rates depending on the 
direction of travel of the logger. It is intended for use when the instrument is integrated into a moving platform.

To set up a logger to sample based on the direction of movement through the water column, click Configuration tab 
> Sampling section, and then select Directional in the Mode drop-down menu.  

Threshold: sets the boundary, based on the previous profile, where the logger should switch to the 
opposite sampling speed
Fast sampling direction: Indicates which direction the instrument should sample at the fast rate

Ascending: indicates that the instrument should sample at the Fast sampling speed during 
ascents.

Only loggers with the |fast sampling feature (|fast8, |fast16, or |fast32) support the ability to sample in a 
burst mode.


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Descending: indicates that the instrument should sample at the Fast sampling speed during 
descents.

Fast sampling speed: has the same meaning as the speed value in the continuous sampling interface, 
but applies only when the logger detects that it is moving in the preferred direction. This must be 
shorter than the provided Slow sampling speed parameter.
Slow sampling speed: has the same meaning as the period value in the continuous 
sampling interface, but applies only when the logger detects that it is not moving in the 
preferred direction. This must be longer than the provided Fast sampling speed parameter.

The logger requires one complete profile to be recorded before evaluating the threshold to switch the sampling speed. 
Due to this requirement, the logger will sample the entire first profile using the Fast sampling speed. Once this has 
been completed it will perform the desired sampling functionality. 

The following provides an overview of how the logger would sample when the current profile either descends to the 
same depth or further than the previous profile (picture gives a global overview of how the logger would behave with 
the previous example on a 20dbar profile setup after it has been started).

In this example, the Fast sampling direction is set to Ascending. 

The following provides an overview of how the logger would sample when the current profile descends to a much 
shallower depth than the previous profile (shows how the directional dependent sampling would behave in the case of 
a profile much shorter than the previous one). In such a case the logger would detect an upcast while slow sampling 
and would then go back to the fast sampling mode.

In this example, the Fast sampling direction is set to Ascending. 
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9.6 Tides and waves

9.6.1 Tides 

Tide is a sampling mode which collects data at a certain rate then averages those samples to produce a single value 
which is stored in the logger memory. This mode uses averaging to remove wave data from the pressure 
measurements.

There are three main parameters required to be configured for averaging mode:

Speed: Specifies the rate at which samples will be collected.
Duration: Specifies the time range over which to average.

The Duration must always be longer than the sampling Speed.
Interval: The repetition period for performing the averaging.

The Interval must always be longer than the Duration.

This sampling mode can be activated by selecting Tide in the Mode drop down menu in the Sampling section on 
the Configuration tab

There are two versions of the Tide Sampling section that can be used, either simple or advanced. This option can be set 
in Preferences.

 Simple form:

This section applies to loggers with the |tide16 or |wave16 feature
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 Advanced form:

In the example above, 1 minute of 8 Hz (8 times a second) samples are taken and averaged. This cycle repeats every 5 
minutes.

9.6.2 Waves

Wave is a sampling mode which collects a specified number of samples at a specified rate and repeats this operation at 
a specified interval. This mode records both wave and tide information. For additional information on planning a wave 
deployment, please refer to |wave deployment planning.

There are three main parameters required to be configured for averaging mode:

Speed: Specifies the rate at which samples will be collected.

A single averaged sample is recorded at the Interval rate. All other samples used to perform the average 
operation are discarded.



This section applies to loggers with the |wave16 feature

All |wave loggers automatically calculate tide data by averaging the wave burst data. There is no setup 
required to determine tide information with the wave logger. 


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Duration: Specifies the number of samples to record.
The range is between 512 and 32768 samples.

Interval: The repetition period for performing the burst.
The Interval must always be longer than the time it takes to obtain the specified number of 
samples.

Wave bandwidth statistics can be generated by specifying two other parameters:

Instrument altitude: Specifies the number of meters above the sea or river bed where the logger will 
be mounted.
Mean depth of water: Specifies the total expected depth of the water in which the logger will be 
deployed.

This sampling mode can be activated by selecting Wave in the Mode drop-down menu in the Sampling section on 
the Configuration tab

There are two versions of the Wave Sampling section that can be used, either simple or advanced. This option can be 
set in Preferences.

Simple form:

Advanced form - sampling at one second or slower:

The Mean depth of water parameter is not stored on the logger. It is only used to compute wave bandwidth 
statistics for pre-deployment analysis.

The Instrument altitude parameter is stored in the logger and is used to calculate wave statistics. This 
parameter can be adjusted post-deployment through the RSK file.


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Advanced form - sampling at 2, 4, 8, and 16 Hz

9.6.3 |wave deployment planning
The following provides a guideline to establish a coherent deployment for |wave loggers.

The |wave logger should be fixed to a suitable support below the surface of the water, such as a dock or other rigid 
mooring. The logger must not be able to move in the water. The figure below offers a view of the logger fixed to a dock 
with a definition of the different water heights.

Mean depth of water: an estimate of the average water depth, used for the initial prediction of 
expected wave frequencies that can be detected. Ruskin will use the actual depth measured by the 
logger for its calculations.
Instrument altitude: The actual height of the logger above the seabed. This is defined by the 
deployment, and the logger must be physically affixed at this height during the installation. 

Given the height of the logger above seabed and the depth of logger as measured during the deployment, the total 
depth of water can be calculated.

The timestamp of the burst for both a Tide and Wave datasets is the beginning of the burst.
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Figure 1. Logger positioning

|wave logger positioning
For deployment planning, refer to Figure 1. Ruskin needs to know the expected mean depth of water (in metres) and the 
expected altitude (height) of the logger above the seabed to provide an estimate of the frequencies and periods of the 
wave that the logger is able to measure. The logger measures water depth/pressure by means of a pressure transducer. 
The physics of what a pressure transducer can 'see' at depth depends on the height of water above the transducer as 
well as the amount of water below the transducer. High frequencies attenuate very quickly with depth. Figure 2 shows 
the attenuation with depth as a function of wave period in seconds (period = 1/frequency). This graph demonstrates that 
the placement of the logger is critical in determining frequencies/periods of the wave data to be captured by the logger. 
The pressure transducer may be placed in any orientation.   

 The basic rule is to place the logger as close to the surface of the water without the possibility that the logger 
will emerge from the water either because of large waves or low tides.
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Figure 2. Wave attenuation as a function of depth for various wave periods. 

This step in the deployment configuration requires that the 'expected mean depth of water', that is the total depth of 
water known from experience with the measurement site, and the 'expected altitude of the logger above seabed', a 
definition to be given to the diver, be entered. Note that on data retrieval the second value will be added to the 
measured depth of water above the logger when performing all wave calculations. 
When waves are enabled, the logger takes multiple pressure readings in a burst which allows for the reconstruction of 
the surface wave time series. There are three parameters which define the wave data:

Measurement speed: this defines the sampling rate or period for individual pressure readings used.
The rate possibilities are 2, 4, 8, and 16Hz
The sampling rate defines several elements of the data capture:

The highest possible frequency visible in the data is limited to ½ the sampling frequency. 
However, this mathematical limit can not usually be achieved because of the attenuation 
characteristics shown above. 
The sampling frequency defines the resolution of the frequency spectrum which can be 
calculated from the wave data. 
The sampling frequency, together with the burst length, define the lowest frequency 
which can be assessed in a wave burst.

Wave measurement period: this defines how often wave bursts are collected.

Burst Length: this defines the number of samples in a wave burst. It must be a power of 2 and is 
chosen from the list: 512, 1024, 2048, 4096, 8192, 16384, and 32768. The longest wave period to be 
assessed is defined by: burst length/sampling frequency

The wave parameters work together to define the range of wave information which can be calculated as well as the 
memory and battery usage. 
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9.7 Gate conditions
Gating is a method to enable the logger based on a condition that may not be time-based. The logger can be made to 
start and stop sampling based on either on the conductivity sensor measurement (Marine wet switch) or by a 
mechanical activation (Twist activation).

The Marine wet switch turns on the sensors to check the value of the conductivity sensor every 15 seconds. If the value 
exceeds 1mS/cm2 logging will start until the conductivity values decrease below this threshold. 

For more information about how the twist activation works, see Twist activation.

If the gating option is available on your logger select the appropriate option from the drop down menu. To enable the 
logger based on contact with water, select Marine wet switch. To enable the logger by twist activation select Twist 
activation. If the logger is to be enabled based on a specific start time, which is set in the Configuration tab, select
None. 

9.7.1 Twist activation
If this option is available and selected, the logger starts or stops sampling based on the action of closing or opening the 
battery end cap. 

Marine wet switch

The threshold value for this setting may not be suitable for freshwater applications as many freshwater 
sources would not exceed 1mS/cm2.


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When this option is selected, the logger starts to sample based on the Twist ON/OFF position rather than a schedule. To 
start sampling first click enable logging, the logger status will then become "paused" until the battery end cap is closed 
to the ON position. To pause the sampling, turn the battery end cap to the OFF position. The logger will vibrate to 
indicate if it is sampling or paused. A long vibration indicates that the logger is sampling and three short vibrations 
indicate that the logger is paused. 

9.8 Fetching and streaming data
The logger is capable of fetching measurements from the logger when connected over USB from the internal port or, if 
an external connector is available, over USB or RS-232/485.

If you are still connected to the logger via USB, you can click Fetching ( )in the Plot view toolbar. A graphical display 
appears of the samples fetched from the logger at the default speed for the logger type rather than of the samples that 
are scheduled and being stored on the logger.

Steps

Under the Options section of the Configuration tab, select Serial from the Realtime drop down 
menu. 

RBRquartz3 BPR|zero

The RBRquartz3 BPR|zero does not have this feature



If you have an underwater RS-232 interface, select Serial from the Realtime drop down menu and RS232 from 
the Mode drop down menu.


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If you have an RS-232 interface, select RS232 from the Mode drop down menu. If you have an 
underwater USB interface or RS485, select USB or RS485 from the Realtime drop down menu. 
For an RS-232 or RS485 connection, select a connection speed from the Serial drop down list.  

If you are interfacing to an external system that requires a control signal input, such as a modem with a DTR input, you 
will need to configure the parameters for the auxiliary output control signal from the datalogger.

After the logger setup is complete and the schedule is enabled, the logger will automatically output as sample reading 
at the set sampling rate.

9.9 Mobile settings
If you have a mobile device, you can use it to configure, download, and view data from a Wi-Fi-capable data logger. The 
Ruskin app is available on the Apple App Store and Google Play Store.

If you intend to use the Ruskin app, you are advised to enable Mobile data storage on the logger. Do not enable it for 
non-Wi-Fi capable loggers. For additional information about the Wi-Fi module, see the Wi-Fi section of the RBR 
instrument guide.

With Mobile data storage selected, the logger data is parsed differently so that the download is faster over WiFi and a 
feature called cast detection is activated. The cast detection feature separates each profile into groups of down and 
upcasts to make viewing of the profiles easier on the mobile device. 

To enable compatible storage for mobile devices in Ruskin, connect the data logger to a computer running Ruskin (not 
a mobile device) and go to the Options section of the Configuration tab and select Mobile from the Storage drop-
down menu.

 

9.10 Autoranging and fixed gain
Certain sensors, specifically turbidity and fluorometer sensors are capable of autoranging. The logger can change the 
gain setting on the front-end amplifiers in order to select the most appropriate range based on the environment being 
measured. The logger can also set the gain on the sensor to a fixed value selected by the user, rather than allowing the 
logger to select the gain as it measures.

Steps

Navigate to the Ranging sensors section of the Configuration tab.
Any sensors present capable of autoranging are shown in Sensor. Select the sensor you want to 
configure from the list provided. 
Select the required gain value from the available selections in Range.
Repeat the above steps for the next available autoranging sensor.

Fixed gain:
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Autoranging (Automatic gain setting):

Range change events are displayed in the Plot view when the Display diagnostic is selected from the Events button, 

, located in the Plot view toolbar. Range change events are displayed as RANGE XX Units where XX indicates the 
current range and units are the units of the sensor – typically NTU for turbidity sensors and μg/l for fluorometers. For |
fast sampling where the change may be occurring over a number of samples the event is displayed as RANGE CHG and is 
followed by the final range event.

9.11 Voltage channel parameters
In the Voltage sensors section of the  Configuration tab, you can set the sensor parameters for the sensor attached to 
the voltage channel. Select the appropriate voltage channel and enter the sensor latency and the sampling current. 
These parameters are used in the deployment time calculation (battery use) and for determining minimal sampling 
intervals. 

 

9.12 Valve control
In the Valve control section of the Configuration tab is specific to the RBRquartz3 BPR |zero. In this section you can see 
the current status of the valve position, manually set the position and schedule the movement of the sensor for the 
deployment.

You must enter these parameters for sensors not supplied by RBR.
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The Status shows the current position of the valve, this can be toggled manually using the Set 
positions options atmospheric or marine and will take effect immediately. The movement of the valve to the 
atmospheric position for the deployment can be set by selecting the Schedule movement checkbox. When the 
checkbox is selected, the controls to set the Duration, the time spent in the atmospheric position, the Interval, the 
time between valve movements to the atmospheric position,  and whether or not the unit will Skip first atmospheric 
duration become available. See the Valve section of Configure a logger for more details.

9.13 Derived channel parameters
When configuring your logger, you can change the default values of parameters that are used to calculate derived 
channels.  These values are stored in the logger itself and are used in place of the values in Options menu > 
Preferences > Derived channels.

In the Parameters tab, you can configure the parameters which are used to calculate derived channels on a logger that 
supports derived channels.  

Valve movement and external power

The valve will only move when the unit is powered externally. The 8xAA batteries (any chemistry, including 
LTC) installed in the instrument are intended only for purposes of sustaining the instrument during external 
power interruptions of a few minutes.


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9.14 Deployment

Once you have ensured that the batteries are fresh, inspected the O-rings, and programmed the logger (see Configure a 
logger), the instrument is ready to be deployed.

There are three precautions you should take to avoid damaging the logger and maximize the deployment autonomy:

Pay attention to the maximum pressure rating. All loggers with pressure sensors are individually rated 
to a maximum depth/pressure. This is indicated by the label which is placed on the logger's sensor 
end cap. Loggers that do not have a pressure sensor do not have this label but are limited by the 
maximum depth/pressure rating of either the logger housing itself or of the sensors.
Avoid physical stress to the logger. Any type of clamp or bracket which concentrates the stress to the 
logger body is not recommended for use in logger mooring, mounting, and/or other deployments. 
Stress due to improper mounting may cause the logger to leak, resulting in the loss of valuable data or 
permanent damage to the electronics. RBR can provide proper mooring and mounting clamps suited 
to your specific application.
Use desiccant. If the logger is closed up in a warmer environment than the deployment environment, 
internal condensation can result. Since condensation may cause the circuitry to malfunction, the 
installation of desiccant prior to deployment is strongly advised.

9.15 Automatic tasks
When working with a large number of similar instruments, Ruskin offers various automatic tasks, which can be toggled 
on and off from the Instruments menu, or by right-clicking the "Instruments" group in the navigator view.  Icons 
indicating the current state will be displayed on the "Instruments" group.  Since these tasks can change the state of the 
logger, the on/off state defaults to off each time Ruskin is run.
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Figure 1.  Instruments menu showing automatic tasks options.  If a task is enabled, it will show a check mark.

Figure 2.  Right-clicking on the "Instruments" group of the navigator view will show the automatic tasks.  If a task is 
enabled, it will show a check mark.

Figure 3.  "Instruments" group of the navigator view with icons indicating that auto-download and auto-deploy are 
enabled.

9.15.1 Auto-download
When an instrument is detected, it will automatically start a download process and store the file using the common 
logger download naming scheme (serial number, date and time of download) in the last "save to" directory chosen.  
Other than possibly creating unwanted files, this option is safe since it does not alter the state of the logger.

9.15.2 Auto-stop
When an instrument is detected, it will automatically stop the instrument if the instrument was previously enabled.  If 
auto-download is not also selected, a warning will be displayed about downloading the instrument data.  It is not 
possible to re-enable the instrument without erasing the instrument's memory, so it is advised to also use the auto-
download feature at the same time, or ensure that the data is downloaded prior to re-enabling the instrument.
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9.15.3 Auto-deploy
When an instrument is detected, the instrument will be stopped and then reprogrammed with the last known 
configuration settings.  It is highly recommended to also use auto-download with this setting since the instrument 
memory will be erased during the deployment set up.  To use this feature, first connect an instrument that will act as 
the model and configure that instrument with the desired settings and then turn on auto-deploy.  Each instrument 
connected, if it supports the same capabilities of the model instrument, will be configured to match the scheduling of 
the model instrument.  Auto-deploy implies auto-stop since the instrument must be stopped to update it with the new 
schedule information.
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10 Download

10.1 Download data from the logger
You can download data from a logger at any time. If you stop running a schedule, you must download the data before 
you restart the schedule to prevent the data stored so far from being lost. It is not possible to start logging without 
erasing the memory contents.

Steps

From the Configuration tab select Download. 
The Save as RSK dialog box appears.
Specify a location and a name for the data file. 
By default, the RSK file name uses the Ruskin file naming convention. For more information about the 
naming convention, see File naming convention below. 
The name of the new dataset appears and is highlighted automatically in Navigator view > Datasets. 
The Properties view changes to the new dataset and contains the following tabs: Analysis, Overview,
 Channels, and File Info. All the data that was stored on the logger at the time of the download is 
automatically plotted in the Plot view.

10.2 File naming convention
In Ruskin, by default, the name of a data file is composed of the following information:

The first six digits represent the logger serial number.
The next eight digits represent the current year, month, and day.
The next four digits represent the current time to the minute.
The file extension indicates the file format and should not be changed. If you change it, the file 
extension that you specify becomes part of the name, and the required extension is appended.

For example, the file named 911936_20090522_1613.rsk contains data for a logger with a serial number of 911936 
whose data was downloaded in 2009 on May 22 at 4:13 pm.

Downloading data again while the same schedule continues to run, picks up the same data plus any data 
stored since the last download.

You can add a comment after downloading a dataset.


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11 Calibration tab
The Calibration tab displays the calibration coefficients for each parameter (sensor) present and the date and time of 
the last calibration. Selecting the sensor from the dropdown menu Parameter toggles between the calibrations for the 
different sensors on the unit.

You can request a calibration quote for your logger by selecting Request calibration quote and sending the 
information directly to RBR Ltd. In the Calibration tab, click Request calibration quote, and when the Request 
calibration dialog box appears, enter the appropriate information. Make sure to verify that all information is correct 
before sending the request. You can edit any of the coefficients and use Store calibration to save the new coefficients 
to the logger.  Use Revert calibration to recover to the original coefficients if you have not already selected Store 
calibration. 

Calibration coefficients are calculated for each sensor, and the coefficients are stored in the logger. Calibration 
certificates are provided for each sensor and contain both the calibration equation and the coefficients. Hard copies are 
provided with each shipment, and the documents are contained inside the shipping box. Please refer to the calibration 
certificates for the coefficients and residuals. RBR can replace lost or misplaced calibration certificates.
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12 Update firmware
Instrument firmware upgrades can be performed from within Ruskin without having to return the instrument to the 
factory. Ruskin automatically checks to see if a newer version of firmware is available and displays a message in the 
Information tab.

Click the Update firmware button to upgrade the logger firmware. The following screen will appear:
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If for some reason RBR needs to supply a version of firmware, the following method is used to manually update the 
logger firmware.

Click the Instruments menu > Update instrument firmware. 

Steps

In the Instruments menu, click Update instrument firmware. 
The Update logger firmware dialog box will appear. 
Click the instrument drop down to select the instrument you wish to upgrade.

A default firmware image will be selected for your instrument. 
If RBR supplied a firmware file see Manually adding a firmware image to Ruskin

Click Proceed to start the firmware upgrade. 
A progress bar shows the status of the upgrade. Once the firmware upgrade is complete, the message 
Update completed successfully appears at the top of the dialog box.
If the upgrade doesn't complete successfully, click Proceed again to retry until successful. 

Do not disconnect the logger until the process is fully completed. Disconnecting the logger during this process 
may render the logger inoperable.



Contact RBR for instructions before proceeding. This method of updating the firmware should only be 
attempted with the assistance of RBR.


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Click Close.

12.1 Manually adding a firmware image to Ruskin

If for some reason RBR needs to supply a version of firmware, the following method is used to manually add that 
firmware image to Ruskin.

Click the link at the bottom of the Update instrument firmware dialog.

Click the Select file button and browse to the location of the firmware update file provided. The file 
will have the extension .rbrfw.
Click Import.
Click Close.

Occasionally the logger will not reappear in the Navigator view following a successful upgrade. If this 
occurs, disconnect your logger from the USB port and then reconnect to re-establish communication.





RBR#0006105revH  –  66

1.
2.
3.

13 Datasets

13.1 Open a stored dataset
You can open any stored dataset to explore its contents.

Steps

Click File menu > Open dataset. 
Double-click the .rsk file that contains the data that you want to view. 
The name of the dataset appears and is highlighted automatically in the Navigator view. The 
Properties view changes to the dataset. The data in the file is automatically plotted in the Plot view.

13.2 Analysis

13.2.1 Analysis tab
The Analysis tab contains information and settings for configuring the calibration information and to display statistical 
information. You must already have an open dataset to view and configure these settings. For information about how to 
open a dataset, see Download.

Cursor tab
When a file is selected and plotted, the Analysis tab can be selected to display information about the dataset channels 
and their values.

To close a dataset, right-click its name in the Navigator view and click Close dataset. Or use File > Close 
dataset



Ruskin performs an integrity check that is intended to make sure that older data files are compatible 
with newer versions of Ruskin software. This information is displayed in File info. If the file requires 
updating the message indicates the issue with the file, and how long an update will take.

RBR strongly recommends that all files that have issues be updated.


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This table reports the value at each sample number when selected in the plot referenced to the vertical black cursor.

The sample number and time of the sample are displayed.

Selecting Display statistics gives you the ability to determine the average value and standard deviation over a range of 
samples. Change the number of samples in the average by using the spin buttons. The grey bar that appears on the plot 
view is the range of the samples in the average.
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Calibration tab
When a file is selected and plotted for re-calibration the Calibration tab can be selected to assist with calculating 
calibration coefficients, see User calibration .

13.3 Overview
When a file is selected and plotted the Overview tab can be selected to display general information about the dataset.
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This is also the form on which you can enter a comment for the dataset and then press Save comment to save it.

13.4 Channels
The Channels tab displays three additional tabs: Information, Calibration, and Parameters.

The Information tab displays the measured parameter, the sensor manufacturer and the range 
setting. The type of derived channels and how it is calculated is displayed in a separate table.
The Calibration tab displays the calibration coefficients for each sensor.
The Parameters tab displays the values of the parameters, default values if other required 
parameters are required and the method used to calculate the derived channels.

13.4.1 Information tab
The Information tab displays the measured parameters, the sensor manufacturer and the range setting (if applicable). 
It also shows any derived channels that are available and a description of the methodology used in the calculation of 
that derived parameter.

T-string

Thermistor strings have channel 1 referring to the node at the end of the string and the last channel being the 
node closest to the connector.


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13.4.2 Calibration tab
The Calibration tab displays the calibration coefficients and temperature correction coefficients (as applicable) for 
each channel (sensor) and the date and time of the last calibration.

You can edit any of the coefficients and use Store and recompute data to recalculate the dataset. Use Revert 
calibration to recover to the original coefficients if you have not already selected Store and recompute data. To 
recover the original calibration coefficients edit one of the values and click in another cell. The Use deployment 
calibrations checkbox then becomes active and unchecked. Check this checkbox to restore the coefficients used by the 
logger and then press Store and recompute data to save the coefficients.

13.4.3 Parameters tab
When a file is selected and plotted, the Parameters tab can be selected to display the parameters used to calculate any 
applicable derived channels.

The tab reports the relevant derived channel information for the sensors on the logger. The parameters can be edited to 
change the derived channel calculation. Once a parameter is modified, the Update and recompute and Revert 
settings buttons become active.

Revert settings rereads the RSK file and populates the form with the parameters from the file. Update and 
recompute writes the new parameters to RSK file and re-displays newly calculated data.

The following example is for a  CTD and dissolved oxygen logger where you can change the calculation parameters to 
calculate the derived channels:
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Selecting the Seawater derivation in the Parameters tab results in a depth calculation based on UNESCO Technical 
paper 44.

The depth derivation equations can be found under the menu item Options menu > Preferences > Derived 
Channels > Depth tab. 

For |wave loggers, you can change the wave calculation by adjusting how the depth is calculated and by adjusting the 
instrument altitude. This function is available in the 'Configuration' tab and under the 'Sampling' tab.

13.5 File info
When a file is selected and plotted the File info tab can be selected to display information about the file.
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If the message A new version of the RSK file format is available. appears, click Update. The update process may take 
some time, however, Ruskin does estimate the time with the message The anticipated update duration is <time period>. 

13.6 Plot view
You can use the Plot view to view a graphical display of data in datasets or live data. When viewing live data, the logger 
must still be attached.

A toolbar at the top of the Plot view contains various buttons to help you customize, explore, and export the graphical 
display.

Each channel appears as a different colour in the graphical display. These colours are specified for all graphical displays 
in Options menu > Preferences > Plotting and can be changed there only. You can also change other defaults affecting 
the Plot view in Preferences. For information, see Specifying plotting preferences

You can click a particular time (location) in the plot to view each channel value and related statistics at that time. A 
"double lollipop" vertical black line marks the place. The Cursor tab panel above (or on the side of the plot for live data) 
displays the channel values, units, the sample number, and the time that the data was measured.

For datasets only, you can select the Display statistics checkbox to view the average value and standard deviation for 
each channel based on the number of samples that you specify. 

If you want to copy the data to the clipboard and then paste it into another application, select a row, a column, a cell or 
click on the word channel for the entire table and then click Copy. 

There are two formats of RSK file: full and EP. EP stands for Easy Parse (mobile compatible format that is 
typically used with Wi-Fi enabled loggers). Only EP format files can be displayed on a mobile device. EP format 
files have calibration coefficients that cannot be edited, hence you cannot recalculate EP format files.



Files created by older versions of Ruskin must be updated to ensure compatibility. Failing to do so may result 
in odd graphical display and incorrect reporting of the sample values.



Scaling of the data is based on the minimum and maximum value sampled for each channel - sometimes there 
are erroneously high or low values that may make the real data appear incorrect. Use the vertical zoom 

 to increase the scale of the data displayed.


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The graphical display for each dataset appears on its own tab in the Plot view. The dataset file name appears at the top 
of the tab.

13.6.1 Thumbnail view
A downsampled representation of the dataset appears in a thumbnail view, along with an indicator of the current 
plotted time range.  The indicator can be positioned on the thumbnail view by clicking on the thumbnail view or 
dragging the indicator.  The indicator can be resized by dragging the edges, which will zoom the plot along the time 
domain to match the new indicator size.  The thumbnail always shows time-domain data, even if the plot is switched to 
depth-domain mode.

13.6.2 Live data
You can use the Plot view to view a graphical display of logger sampling.  The data can come from one of two sources: 
fetching or streaming.  Fetching can be used on a logger that is either not enabled or enabled without a streaming 
option.  Streaming can be used on a logger that has been enabled.  If fetching is used on a logger with streaming 
selected and the logger is enabled, the current file used for the fetching data will be closed and a new file started for the 
streaming data; fetching will be disabled.

The graphical display for live data for each logger appears on its own tab in the Plot view. The logger model and serial 
number appear at the top of the tab.

13.6.3 Plot Tools

Dataset toolbar

Live data collection support in Ruskin is intended for debugging, development, and schedule trial purposes 
only and is not intended as a robust data collection solution.  The performance will degrade significantly if 
large (>50-100K samples, depending on hardware) data collections are performed, especially if there are a 
large number of events being reported.


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Live plot toolbar
The live plot toolbar appears to the right of the dataset toolbar.

Tools for datasets and live data

Button Purpose Use

Filter Changes the type of annotation for the navigation 
buttons

If an annotation is selected, switching filters zooms the 
view to the newly selected annotation.
If no annotation is selected and switching filter from one 
profiling annotation type to another (profile, upcast, 
downcast), the view does not change.
If no annotation is selected and switching filter between 
categories (profile, upcast, downcast to any other non-
profiling annotation type, or any non-profiling annotation 
type to any other annotation type), the view moves to the 
first annotation of the new category.

Comment → Profile moves to the first profile
Profile → Comment moves to the first comment
Comment → Downcast moves to first downcast
Profile → Downcast does not move.

Move to 
first, 
previous, 
next, and 
last

Move to the first, previous, next, and last annotation of 
the filter type

If the annotation is selected also moves the selection

Index The current annotation index, which can be edited.

If the currently selected annotation matches the time 
domain extent the text will appear blue, otherwise the 
text will be red

Click the middle of the index (the '/' ) to zoom to the 
annotation.
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Button Purpose Use

Create 
annotation

Select the type of annotation to create.

After selection, click and drag left/right on the main plot 
to create the annotation. When the click is released the 
annotation will be created as a temporary annotation, 
selected, and show its editable tooltip.

Profiles or geodata cannot overlap the same type - new 
annotations will fill the available space between existing 
profiles.

Cast 
detection

Runs a cast detection algorithm based on depth and 
conductivity to automatically generate profiles and casts

Event 
visibility

Turn on and off the visibility of the various levels of events 
(error, warning, information, and diagnostic)

The annotation must be edited (such as adding a 
title or description, or, in the case of profiles, by 
adding an up or downcast) and saved (press 
ENTER/Return, or click the green checkmark on 
the tooltip) before it will be saved in the RSK file.



Only available in the time domain

Overwrites logger generated cast events and 
profiles


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Button Purpose Use

Annotation 
collapse

Toggles the annotations collapse or expanded state for 
an entire category of annotation.

In the expanded state all data within the time bounds of 
the annotation will be displayed.

In the collapsed state all data within the time bounds of 
the annotation will be hidden and a time break marker 
will be visible on the time axis. The annotation marker 
will appear as a point annotation.

Individual annotations can be collapsed or expanded 
from the toolbar in the annotation bubble.

Zoom 
control

Zoom in/out horizontally, vertically, and reset the zoom 
to display the maximum extent of each axis

Zooming the range will centre the data on the currently 
selected sample.

Auto-
ranging

Toggles the auto-ranging of the channel axes

Export plot Exports the current view of the main plot to pdf or png

Disabling the auto-ranging of the axis can be 
useful for looking at trends in data


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Button Purpose Use

Data 
rendering 
type

Choose lines, shapes, or lines and markers for the trace 
lines

Toggle 
channel 
visibility

Turn on or off channels to be visible in the plot view

Toggle on raw values removes the calibration equation 
from the sensor value

Plot by 
depth

Toggles between plot by time and plot by depth

Show GPS 
map

Launches a map which plots all the GPS location 
annotations in the dataset. The map will infer track lines 
based on the timestamps of the acquired locations.

If no data appears in the Plot view, try changing 
the rendering to "Display Markers".  Time spans 
that are larger than expected will cause breaks 
between data points and lines will not be drawn 
connecting those points, whereas markers draw 
at each individual point.



If there is no depth channel the plot would then 
use the next pressure or pressure derived channel 
starting from the bottom of the channel list


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Tools for live data

Button Purpose How to use

 
Toggle the 
side data 
panel

The side data panel appears beside the charts and shows the 
file location that will be used to capture samples, the number of 
samples collected, the values of the last received sample, and 
the currently selected sample.  The side panel can be toggled on 
and off with this button.

Live plot time 
range 
selection

Click the button to display a drop-down list of time span 
options to display the data by time period. For example, display 
2 minutes of data. You can also choose to display all of the data 
collected.

Start or pause 
fetching

The logger supports either streaming or fetching data. Fetching 
is the action of asking the logger to take a reading and report it. 
Ruskin displays the fetched data every 1-2 seconds. Fetching is 
disabled if the logger is enabled and has streaming turned on.

13.6.4 Shortcuts / Controls
Data cursor:

Click on the main plot to set the data cursor (double lollipop indicator).
Move to the previous/next data sample: Left/Right Arrow Key

To move by hundreds of samples, use Shift - Arrow
To move by ten thousands of samples, use Alt - Arrow
To move by millions of samples, use Shift - Alt - Arrow

Annotations
Double click on an annotation bar to zoom in to the range of the annotation.
Click and drag on the edge of an annotation bar to resize the annotation, if the annotation is 
resizeable (CELL GPS annotations are not).
Click and drag on the annotation bar to move the annotation, if the annotation is moveable 
(CELL GPS annotations are not).

Main Plot
Double click on the plot to reset to fully zoomed out.
Shift-click and drag on the plot to select a zoom region.  The zoom region will be denoted by a 
rectangle.  Make sure to press shift before clicking.
Control-click and drag on the plot to pan the plot.  Make sure to press control before clicking.
The mouse wheel will zoom the plot in/out based on the current mouse position.

Main Plot Axes
Double-click on an axis to set the axis to auto-range (show the full range of data).
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Click and drag an axis to pan the axis.
Shift-click and drag an axis to zoom the axis in or out.
The mouse wheel will zoom the axis in/out based on the current mouse position.

Thumbnail
To resize the viewable range, click and drag on the handles (grey bars) on or use the mouse 
wheel within the viewable range indicator.
Click and drag the viewable range indicator to pan
Click on a region not covered by the viewable range indicator to centre the viewable range at 
that location.

13.7 Exporting datasets
You may want to share your data with others or analyse your data using other software. You can export data as a text 
file, which can then be imported into many applications, or export it in a particular format for analysis such as Microsoft 
Excel or OceanDataView.

You must already have downloaded the data to a dataset or opened an existing dataset.

Steps

Right-click the dataset whose data you want to export, and hover to Export as to open a submenu, or 
use File menu > Export dataset.

Select the appropriate export format (Excel, Text, OceanDataView or Bin).

Specify a location and a name for the data file. 
Click Save.

Annotations can be exported to individual files by selecting the annotation category you would like to 
export. 



RSK files can be imported directly into Matlab with our toolkit RSKtools that is available for download 
from our website at www.rbr-global.com. The RSK file is a single file database based on SQLite that 
allows us to have very large files with high-speed access to any part of the dataset.



http://rbr-global.com/support/matlab-tools
http://www.rbr-global.com/support/matlab-tools
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14 User calibration

Calibration coefficients are calculated for each sensor and the coefficients are stored in the logger. Calibration 
certificates are provided for each sensor and contain both the calibration equation and the coefficients. Hard copies are 
provided with each shipment and the documents are contained inside the shipping box. Please refer to the calibration 
certificates for the coefficients and residuals. RBR can replace lost or misplaced calibration certificates. 

Change calibration coefficients
Sensors such as dissolved oxygen, turbidity and pH that can be field calibrated will require you to update the 
calibration coefficients for these channels periodically. You may also need on occasion to manually enter new 
coefficients, although this is not recommended for factory calibrated sensors (for example C, T or D) unless instructed 
by RBR.

Steps

You can view static information about an instrument at any time as follows:

In the Navigator view, under the Instruments list, click the appropriate logger.
Click Analysis tab > Calibration tab to show the current calibration coefficients.
To manually change a coefficient, click on the appropriate entry in the table (C1, C2, C3, etc.). The 
current entry will be highlighted, and the new value can be typed.
If a two point calibration has been performed, and calculated coefficients have been copied, right click 
on either the Time or Parameter entry for the parameter you wish to modify. Select Paste to selected 
row from the drop down menu.
Click Store calibration to write the calibration coefficients to the logger.
If you need to revert to previous coefficients, click Revert calibration.

14.1 N-Point calibration
Sensors such as pH, Dissolved Oxygen (Oxyguard or Rinko) or turbidity generate a voltage output that is proportional to 
the value of the parameter being measured. To calibrate these sensors, Ruskin offers an N-point calibration method to 
generate calibration coefficients.

14.2 Oxyguard DO calibration

If you do not click Store calibration, the coefficients will not be written to the instrument, and will be lost 
once your session is closed. 



The Oxyguard DO sensor has a true zero point and therefore it can be calibrated using the single-point 
calibration method using a reading at 100% oxygen concentration only. The 100% calibration should be 
performed at the expected temperature and salinity of the deployment environment.

If the logger has a pH/ORP sensor and Oxyguard DO sensor, it is advisable to ensure that the pH/ORP and 
Reference sensors are submerged in the water during measurement.


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Equipment and Materials

Two Large mouth beakers.
Sodium sulphite Na2SO3
Aquarium air pump.
Magnetic stirrer.
Water

Preparing solutions

 Reference Point 1 solution – Oxygen saturated solution at expected temperature and salinity of deployment 
environment

Fill the large beaker with 2 L of water and install magnetic stirrer.
Bubble air through the water using an air pump (an aquarium air pump would work).  
Switch ON the air-pump and the magnetic stirrer.

Reference Point 2 solution – Dissolved oxygen concentration of zero

In a beaker, dissolve approximately 5 tsp of sodium sulfite (Na2SO3) into 500 mL tap water.  
Mix the solution thoroughly with a magnetic stirrer. The solution will be oxygen-free after 15 minutes. 

Steps

In Ruskin, configure the instrument to sample at a fast rate, between 6 Hz and 3 seconds. 
Use Sync to PC to ensure the logger clock is synchronized to the PC clock, and ensure the end time is 
set so that the logger will keep sampling until calibration is complete.
Submerge the dissolved oxygen sensor in the Reference Point 1 solution for at least 15 minutes near 
the stirrer so that it is in the best mixed area of the bath.
Take sample readings for at least 15 minutes for the 100% calibration point, making note of the time 
that the sample is being measured.
Submerge the dissolved oxygen sensor in the Reference Point 2 solution for at least 15 minutes for the 
0% calibration point, making note of the time that the sample is being measured.
Retrieve the data from the data logger as per the steps in Download.
The calibration data should now be displayed in the Plot view. In the Properties view, go to Analysis
tab > Calibration tab.
Select the dissolved oxygen sensor type from the drop down list. 
The Number of Samples spinner box is automatically set to 100. 
This value is the number of sample points Ruskin will average the calibration coefficients for the 
sensor. Typically, this value should be in the range of 50 to 100 samples.
Click on a stable point in the Plot view corresponding to 100% oxygen. In the table in the first row, 
under Real Avg, enter 100 and press enter. 
Select the check box in the second row in the table, then click on a stable point in the Plot view 
corresponding to 0% oxygen. In the table in the second row, under Real Avg, enter 0 and press enter.
Ruskin automatically calculates the calibration coefficients, and these values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.
Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the data 
logger.
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14.3 Rinko optode calibration
The Rinko optode can be calibrated using Ruskin N-point calibration.

Equipment

Two Large mouth beakers
Sodium sulphite Na2SO3
Aquarium air pump
Magnetic stirrer

Preparing solutions
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 Reference Point 1 solution – Oxygen saturated solution at expected temperature and salinity of deployment 
environment 

Fill the large beaker with 2L of water, and install magnetic stirrer.
Bubble air through the water using an air pump (an aquarium air pump would work).  
Switch ON the air-pump and the magnetic stirrer.

 Reference Point 2 solution – Dissolved oxygen concentration of zero

 In a beaker, dissolve approximately 5 tsp of sodium sulphite (Na2SO3) into 500 mL tap water. Mix the 
solution thoroughly with a magnetic stirrer. The solution will be oxygen-free after 15 minutes. 

Steps

In Ruskin, configure the logger to sample at a fast rate, between 6 Hz and 3 seconds. 
Use Sync to PC to ensure the logger clock is synchronised to the PC clock, and ensure the end time is 
set so that the logger will keep sampling until calibration is complete.
Submerge the dissolved oxygen sensor in the Reference Point 1 solution for at least 15 minutes near 
the stirrer so that it is in the best mixed area of the bath.
Take sample readings for at least 15 minutes for the 100% calibration point, making note of the time 
that the sample is being measured.
Submerge the dissolved oxygen sensor in the Reference Point 2 solution for at least 15 minutes for the 
0% calibration point, making note of the time that the sample is being measured.
Retrieve the data from the data logger as per the steps in Download. 
The calibration data should now be displayed in the Plot view. In the Properties view, go to Analysis
tab > Calibration tab.
Select the dissolved oxygen sensor type from the drop down list. 
The Number of Samples spinner box is automatically set to 100. 
This value is the number of sample points Ruskin will average the calculate the calibration coefficients 
for the sensor. Typically, this value should be in the range of 50 to 100 samples.
Click on a stable point in the Plot view corresponding to 100% oxygen. In the table in the first row, 
under Real Avg, enter 100 and press enter. 
Select the check box in the second row in the table, then click on a stable point in the Plot view 
corresponding to 0% oxygen. In the table in the second row, under Real Avg, enter 0 and press enter.
Ruskin automatically calculates the calibration coefficients, and the values appear in Calibration 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.
Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the data 
logger.
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14.4 Turbidity calibration
The Seapoint turbidity sensor is calibrated by RBR with a two-point calibration technique. We recommend doing a two-
point calibration performed under fluorescent lighting.

Alternatively, one can do a single point calibration. If doing a single "0" point calibration in distilled water the 
calibration will only correct the coefficients for an offset.  If only a single non zero point is performed the calibration will 
recompute the slope coefficient. We recommend to only perform a "0" point calibration unless you are confident on 
your non zero standard.
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14.4.1 Two-point calibration
Equipment (entire logger submerged)

4000-FTU Formazin standard – 500ml
Distilled water – 5 L
Black-walled, wide-mouth container (large enough to hold the logger)
Volumetric flask 1000 ml, class A
Volumetric flask  200 ml, class A
Stir stick

Steps (preparing solutions)

In Ruskin, configure the data logger to sample using a 10-second sampling interval and set the sensor 
to autoranging - see Autoranging and fixed gain. 
Use Sync to PC to ensure the logger clock is synchronized to the PC clock, and ensure the end time is 
set so that the logger will keep sampling until calibration is complete.
Flush the sensor, container and glassware with distilled water and dry them.
Fill the black wall container with 5000 ml distilled water using the large volumetric flask.
Set the sensor in the container until the sensor is fully submerged in the distilled water. 

Record the data in distilled water for five minutes. 
This is the zero-turbidity calibration point.
Fill the 500 ml volumetric flask with Formazin Standard. Remember to gently shake the bottle before 
opening the Formazin solution.
Add 500 ml Formazin Standard to the black wall container with distilled water, and gently mix the 
solution with a stirring stick.
Calculate the value of the standard turbidity solution at calibration point according to the following 
formula: 
 

After five minutes, remove the logger from the calibration container and wash the sensor head under 
regular tap water.
Retrieve the data from the data logger as per the steps in Download. 
The calibration data should now be displayed in the Plot view. In the Properties view, go to 
the Analysis tab > Calibration tab.

If you plan to submerge only the sensor, you can decide on the container volume and adjust the solution 
volumes appropriately.



The distance from the sensor's windows to the container wall must be at least 20 cm. If possible, place 
a dark cover on the calibration container and avoid direct light on the container.



Calculating dilution

TuSTD = TuSTK*VTOT/(VDW+VTOT) = 363.63 FTU
Where:
TuSTD = turbidity of the standard solution (FTU)
TuSTK = 4000FTU – turbidity of the stock solution
VTOT = 500 ml volume of stock solution at calibration point (ml)
VDW = 5000 ml - initial volume of distilled water


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Select the Turbidity sensor type from the drop-down list.  
The Number of Samples field is automatically set to 100. 
This value is the number of sample points Ruskin will average to calculate the calibration coefficients 
for the sensor. Typically, this value should be in the range of 50 to 100 samples.
Click on a stable point in the Plot view corresponding to 0 NTU. In the table in the first row, under Real 
Avg, enter 0 and press enter. 
Select the checkbox in the second row in the table, then click on a stable point in the Plot view 
corresponding to the reading of your turbidity solution. In the table in the second row, under Real 
Avg, enter the value of your turbidity solution and press enter.
Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.
Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the data 
logger.

By using the above formula and changing the volume of distilled water and Formazin solution, you can 
prepare different calibration points or different volumes for checking the linearity of the turbidity sensor or 
getting close to real turbidity value of standard turbidity solution.


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14.4.2 One-point calibration
Using the same procedure as in the 2-point calibration, one can use only the distilled water or formazin standard to 
generate new coefficients from a single point.

RBR suggests using the one-point calibration for establishing a new "0" value only, as unless one is very confident on 
their non zero point they may put the unit out of specification.

After you have generated a dataset of your single point as described in the procedure above follow the steps below:

Retrieve the data from the data logger as per the steps in Download. 
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The calibration data should now be displayed in the Plot view. In the Properties view, go 
to Analysis tab > Calibration tab.
Select the Tu sensor type from the drop-down list.  
The Number of Samples field is automatically set to 100. 
This value is the number of sample points Ruskin will average to calculate the calibration coefficients 
for the sensor. Typically, this value should be in the range of 50 to 100 samples.
Click on a stable point in the Plot view corresponding to 0 NTU. In the table in the first row, under Real 
Avg, enter 0 and press enter. 
Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.
Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the data 
logger.
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14.5 Idronaut pH calibration
Calibration of the pH sensor should use two or more pH buffers and should be carried out every day that the electrode is 
used for optimum accuracy. It is recommended that a pH 7 buffer be used to check the zero point and an acid and an 
alkaline buffer used to set the slope. RBR uses pH 4 and pH 10 to measure the slope.

Steps

In Ruskin, configure the logger to sample at a fast rate, between 6Hz and 3 seconds. 
Use Sync to PC to ensure the logger clock is synchronized to the PC clock, and ensure the end time is 
set so that the logger will keep sampling until calibration is complete.
Submerge the pH sensor in the pH 4 buffer solution for at least 15 minutes near the stirrer so that it is 
in the best mixed area of the bath. 

Submerge the pH sensor in the pH 7 buffer solution for at least 15 minutes near the stirrer so that it is 
in the best mixed area of the bath.
Submerge the pH sensor in the pH 10 buffer solution for at least 15 minutes near the stirrer so that it is 
in the best mixed area of the bath.
Retrieve the data from the data logger as per the steps in Download. 
The calibration data should now be displayed in the Plot view. In the Properties view, go to 
the Analysis tab > Calibration tab. 
Select the pH sensor type from the drop-down list. 
The Number of Samples spinner box is automatically set to 100. 
This value is the number of sample points Ruskin will average the calibration coefficients for the 
sensor. Typically, this value should be in the range of 50 to 100 samples.
Click on a stable point in the Plot view corresponding to pH 4. In the table in the first row, under Real 
Avg, enter 4 and press enter. 
Select the checkbox in the second row in the table, then click on a stable point in the Plot view 
corresponding to pH 7.  In the table in the second row, under Real Avg, enter 7 and press enter.
Select the checkbox in the third row in the table, then click on a stable point in the Plot view 
corresponding to pH 10.  In the table in the third row, under Real Avg, enter 10 and press enter.
Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.
Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the data 
logger.

Ensure that the pH sensor is rinsed with clean water between each sample reading to avoid 
contamination between buffer values.

Ensure that both the pH and Reference electrode are submerged in the same solution.

If the logger has a pH/ORP sensor and an Oxyguard DO sensor, it is advisable to ensure that the DO 
sensor is submerged in the buffer during measurement.


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14.6 RBRcoda T.ODO - User calibration
Ruskin uses a different calibration method for the RBRcoda T.ODO User calibration than the other DO sensors. This 
document outlines the process to complete a calibration using the plot window method.
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14.6.1 Collecting a calibration file
Please refer to the User Guide section 14 (http://files.rbr-global.com/upload/files/
Ruskin_User_Guide_Standard_loggers_.pdf) for information on collecting data for the dissolved oxygen saturation of 
0% and 100%. This method can be used to do a one-point or two-point calibration. The 100% point, or a reference value 
as close as possible to 100%, is our recommendation for the one-point calibration.

When doing a second point at 0% using sodium sulphite we recommend rinsing the sensor immediately after and then 
leaving it in a saturated bath until it reaches a plateau. This will reduce the possibility of residual being left under the 
foil and keep the solution from affecting the sensor's next samples. 

14.6.2 Performing a calibration
Performing a calibration requires that a calibration region be defined which contains a set of plateau markers. See Crea
ting a calibration region and Plateau detection sections for information on how to generate these items. Once this 
has been complete, reference data must be entered. See the Reference data entry section for details on how to enter 
in reference data. The data for the calibration is summarized on the Cursor tab on the Analysis page. 

Ruskin will automatically calculate new coefficients each time data is altered whether it be an alteration of the plateau 
location or changes to reference data.

If there are residuals that are highlighted in red it may mean that a plateau marker is not seated correctly on the actual 
data of the plateau. Each plateau can be moved into the correct position by clicking on the marker and dragging the 
mouse left or right.

http://files.rbr-global.com/upload/files/Ruskin_User_Guide_Standard_loggers_.pdf
http://files.rbr-global.com/upload/files/Ruskin_User_Guide_Standard_loggers_.pdf
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The Save button will be enabled, and the calibration will be completed once all of the plateau residuals are valid, 
indicated by being highlighted in green colour. Saving the calibration performs two operations; stores the newly 
generated coefficients into the RSK file and recalculates the data and stores the new coefficients into a connected 
instrument with the same serial number. The connected instrument must be stopped to update the coefficients.

14.6.3 Creating a calibration region
Open a dataset containing the calibration data
From the plot toolbar select the annotation creation button. Select the Calibration option from the 
dropdown menu.

Move the mouse pointer to the first data point, hold down the left mouse button, and move the 
pointer to the last data point, then release the mouse button. 
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A calibration annotation will now be created and selected, displaying the information bubble.

Filling in the title and details fields are not necessary; however, they may come in handy if there are 
multiple calibration regions in the same file.
From the Channel selection widget, select the channel for which you want to calibrate. Channels are 
labelled by both name and index.

Click the checkmark in the top right of the bubble to save the changes.

14.6.4 Plateau creation

Automatic

Click the Detect plateaus button in the annotation toolbar.
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If there are existing plateaus, a warning dialogue will pop up, indicating that all existing plateau 
markers will be removed. Click 'Proceed' to continue.

All detected plateaus will be visible as grey markers under the calibration region marker

Plateaus that should not be used can be deleted. See Plateau deletion

Manual

Click the Create a plateau button in the annotation toolbar.
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A single plateau marker will be added to the start of the calibration region.

Clicking the Create plateau button a second time will create a new plateau marker to the right of any 
existing plateaus.

14.6.5 Plateau deletion 
Click on a plateau. The information bubble will appear, and the marker will highlight.

Click the trash can icon
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3. Click Delete on the confirmation dialogue

14.6.6 Reference data entry
Reference data can be entered either manually or automatically. The manual process requires that the operator 
enters a reference value for each plateau. The automatic functionally allows the operator to upload a CSV file 
containing the reference data. By default, the calibration is set to Manual entry mode.

The reference can be edited in units of % or μmol/l by selecting the preferred unit in the drop-down menu.

Automatic
The CSV file for the automatic data entry must have two columns; time (in ISO 8601 format), and data (in float/double 
format). For example:
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Once the file has been selected, a dialogue box will appear asking for you to define the column which contains the time 
and which one contains the reference data:

  

Manual

Click the Manual option.
Click the Reference cell on the plateau to be edited.
Enter in a value and click the Enter/Return key on the keyboard.

Complete these previous steps for all points in the calibration

Time

The time in the CSV file will need to be a value that falls within the region of the plateau, however, the CSV file 
can hold additional rows with times that are outside of the plateau region.


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Saving coefficients
If the residuals are within an acceptable range (highlighted in green) the save button will appear in the Calculated 
coefficients section:

When the Save button is selected Ruskin will try to write the coefficients to the instrument if it is connected:

If it is successful it will display Writing to instrument...Complete 

 

If it is not successful it will display Warning: Unable to find Instrument RBRconcerto #######

Annotation - Reference entry

Alternatively, the reference value can be entered on the annotation for the plateau:

       


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15 Preferences
Ruskin sets global preferences that require no changes in many situations. However, as you learn more about what 
Ruskin can do, you may want to change some of these defaults to better suit your requirements. The global preferences 
include:

Where to store output files
Plotting preferences
Configuring derived channels
Calculating derived channels when sensors are missing

You can change these preferences at any time.

15.1 Specify location for data files
You can control where data files are stored by default. Specify these locations before downloading any data.

Steps

From the Options menu, click Preferences.
In the list on the left side, click General.
In File location, type a directory name in the Directory for RSK files text box, or click Browse to 
locate the directory where you want to store data files. 
Click Apply or OK.

You can change where future data files are stored by default at any time. The change takes effect immediately.

15.2 Specify location for realtime data files
You can control where realtime files are stored by default. Specify these locations before connecting any instrument.

Steps

From the Options menu, click Preferences.
In the list on the left side, click General.
In File location, type a directory name in the Directory for realtime RSK files text box, or click 
Browse to locate the directory where you want to store data files. 
Click Apply or OK.

You can change where future data files are stored by default at any time. The change takes effect immediately.

15.3 Specify location for log files
You can control where log files are stored by default. Specify these locations before downloading any data.

Steps

From the Options menu, click Preferences.
In the list on the left side, click General.

Realtime files are generated when a connected instrument is streaming or when the user enables fetching 
mode on the instrument.


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In File location, type a directory name in the Directory for log files text box, or click Browse to locate 
the directory where you want to store log files. 

Click Apply or Close.

You can change where future log files are stored by default at any time. The change takes effect immediately.

15.4 Specify Language selection
Steps

From the Options menu, click Preferences.
In the list on the left side, click General.
In Language selection, select a language from the list. 
Click Apply or OK.

15.5 Using advanced sampling controls
 Steps

From the Options menu, click Preferences.
In the list on the left side, click General.
In Sampling control, select Enable advanced sampling controls check box to change from the 
simple control.
Click Apply or OK.

15.6 Using advanced calibration controls
 Steps

From the Options menu, click Preferences.
In the list on the left side, click General.
In Calibration control, select Enable advanced calibration controls check box to change from the 
simple control.
Click Apply or OK.

The Preferences dialogue box is shown below:

Log files are used when you request RBR support.

Simple control: provides a default list of fixed values.

Advanced control: provides the user the ability to enter any values.


Simple control: provides the user the ability to view and edit the main coefficients (C) for any channel.

Advanced control: provides the user the ability to view and edit all main and dependency calibration 
coefficients (C,X) for all channels.


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15.7 Derived channel preferences

Derived channels contain calculated data based on data from measured channels. In the Derived Channels section of 
the Preferences dialog box, you can choose additional channels derived from measured channels. You can also set the 
salinity, pressure, and temperature values used to calculate the derived channels when a sensor is not available.

Derived channels are included by default in the Plot view and in datasets.

The derived channels settings in Preferences was originally intended for XR(X),1060, 2050, and 1050 RBR data 
loggers. It does not apply to newer generations.

Newer generations calculate all the possible derived channels for that specific logger.

Use the Parameters tab to set up initial derived channel parameters.

For downloaded files, use the dataset Parameters tab.



If you suspect that the derived channel value is incorrect, check to make sure that the no sensor present
values are correct. For example, if a Dissolved Oxygen saturation measurement is made in a lake at 8 degrees 
but the no sensor present salinity value is 35 and the temperature is 15 degrees the concentration reported 
will be incorrect. Adjust the no sensor present values and re-compute.


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15.7.1 Add depth as a derived channel
If your logger has a pressure channel, you can use its measurements to derive a depth channel. The data calculated for 
this derived channel appears along with measured channels in the Plot view and in datasets.

Steps

From the Options menu, click Preferences.
In the list on the left side of the Preferences dialog box, click Derived Channels.
On the Depth tab, select the Enable Depth Channel checkbox. 
For new loggers, all derived channels are calculated regardless of the checkbox status.
In the Atmospheric Pressure box, type a deciBar value for the atmospheric pressure on the logger or 
use the default value. This value corrects the pressure measurements during the depth calculation.
Click either the Simplified calculation or Seawater calculation, which is a calculation based on a 
UNESCO technical paper:

If you want to use the simplified calculation, type the actual water density, or use the default 
value. Note that for freshwater, the density should be set to 1.0.
If you want to use the UNESCO seawater calculation, specify the latitude of the data collection 
in degrees and minutes.

15.7.2 Add dissolved oxygen as a derived channel
You can derive a dissolved oxygen channel that measures oxygen saturation as a percentage. The data calculated for 
this derived channel appears along with measured channels in the Plot view and in datasets.

Steps

From the Options menu, click Preferences.
In the list on the left side of the Preferences dialog box, click Derived Channels.
Click the Dissolved O2 tab and select the Enable Dissolved Oxygen Channel checkbox. 
For new loggers, all derived channels are calculated regardless of the checkbox status.
If any of your loggers use the Oxyguard DO sensor to measure oxygen saturation and you want to use 
the Weiss equation, select the Calculate concentration using the Weiss equation checkbox and 
select the output unit, one of µMol/L, mg/L or mL/L.
The Weiss equation requires values for temperature and salinity. If your logger does not measure 
these things, you can specify standard values on the No sensor values tab.
If any of your loggers use the Aanderaa Optode DO sensor to measure oxygen concentration, select 
the Calculate concentration checkbox and select the output unit, either mg/l or ml/l.
If any of your loggers use the Aanderaa Optode DO sensor to measure oxygen saturation, select the Ca
lculate saturation using the Garcia and Gordon equation checkbox.
The Garcia and Gordon equation requires values for temperature and salinity. If your logger does not 
measure these things, you can specify standard values on the No sensor values tab.

15.7.3 Calculate derived channels when sensors are missing
When your sensors do not provide the salinity, pressure, or temperature values needed to calculate derived channels, 
you can specify actual values to use instead.

Steps

From the Options menu, click Preferences.
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In the list on the left side of the Preferences dialog box, click Derived Channels.
Click the No sensor values tab.
In the boxes provided, specify the values that you want to use when actual values are not provided by 
your sensors.

15.8 Specifying plotting preferences
You can specify how you want the graphical display in the Plot view to behave by default. With the exception of 
choosing colours for each channel, these preferences can be overridden for a particular graphical display in the Plot
view. 

15.8.1 Channel visibility tab
The Channel visibility tab displays many options to hide or show specific information in the Plot view. These settings 
are applied when displaying a dataset in the Plot view. Some information in this tab is enabled by default. When you 
select any of the checkboxes in this tab, the action is immediate. 

Channel visibility tab with default settings

You can click Apply to save your changes without closing the dialogue box.
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Steps

From the Options menu, click Preferences. 
In the list on the left side, click Plotting. 
On the Channel visibility tab, select the checkbox for the information you want hidden.  
Events appear at the x-axis as a vertical grey line with a brief text to indicate the type of event, such as 
STP for a stop event in a dataset.
To hide all measured channels, select By default, hide all measured channels checkbox. 
To hide all derived channels, select By default, hide all derived channels checkbox. 
To show information, clear the checkbox beside the information you want to be shown. 

15.8.2 Channel colours tab
The Channel colours tab allows you to choose a different colour for each channel that is shown for information 
currently running in Plot view, or from an opened dataset. If there is no colour available that you like, you can create 
your own colour. When you select a colour, the new colour is immediately updated by Ruskin. 

Channel colours tab with the Colour dialogue box to customize a colour for a channel

Steps
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From the Options menu, click Preferences.
In the list on the left side, click Plotting.
Click the Channel colours tab. 
In the channels listed, click the channel you want to change the colour for. 
Click the colour box that appears beside the channel list. 
With the colour dialogue box open, select a colour from the Basic colour area. 
Select OK to apply the colour to the channel. 
To create a custom colour: 

Repeat steps 4 and 5.
Click Define Custom Colours and then choose a colour. 
Click Add to Custom Colours to add the new colour to Custom colours.
Click OK to apply the new custom colour to the channel. 
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